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Figure 3.1 Potential energy landscape in three dimensions.

Figure 4.1 (a) Structure of F1 ATP-ase, PDB entry 2JDI [2]. (b) All residues and water molecules
within 18 Å of the ANP ligand in chain B. (c) Computational model of the active site in chain B;
only the residues most important for the reaction are included. Model courtesy of M. W. Bowler.

Figure 4.2 A simulation cell used for coex-
istence calculations of liquid and solid iron:
(a) end view; (b) side view. The solid phase
should be clear from the more ordered ap-

pearance in (b). There are 980 atoms in the
cell, which are colored by depth from the side.
The rough size of a 64 atom cell is indicated
with lines. Figure courtesy of D. Alfè.

Tutorial 2: Energy surface: structure optimisation
Manuscript for Exercise Problems

Prepared by Ondřej Krejčí, Orlando Silveira and Adolfo Fumega
Developed by Patrick Rinke, Milica Todorović,

Department of Applied Physics
Aalto University, 2022



A quick summary of the exercises
This tutorial will give you a practical understanding of the potential energy surface concept, and
familiarise you with one of the most popular uses of DFT - determination of ground state structures.
The first part introduces geometric optimization of a molecule and how to assess the reliability
of the result. In the second part, you will learn how to build a molecular structure and consider
the problem of local minima. The third part is dedicated to efficiently obtaining and visualizing
electronic structure derived data.

Part I: Local structure optimization

Problem I: Planar hydronium cation H3O+

Problem II: A vibrational analysis of planar H3O+

Problem III: Getting H3O+ right
Problem IV: Pyramidal H3O+

Problem V: Infra-red spectrum

Part II: Exploring conformers and the potential energy surface
Problem VI: Building alanine with a molecular editor
Problem VII: Relaxing alanine with DFT

Part III: Visualising electron densities and eigenstates
Problem VIII: Outputting molecular orbitals
Problem IX: Visualising orbitals

For every exercise, we also provide solutions and sample input files. They can be found in
$TUTORIALS/ directory. However, we strongly recommend to use the provided input files only
in case of time shortage. You will maximize your learning progress by trying to generate the input
files on your own. In case you get stuck with a particular problem, do not hesitate to ask one of
the tutors. An executable of FHI-aims, as well as species files and utility scripts, are provided in
the $COURSE/ directory.

Note: Please do not copy and paste the description in this pdf into your input files.
Typically, invisible characters from the formatting are copied, too. FHI-aims will
revoke these characters and your calculations will not start.
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Additional tools and programs
• Speed up with parallel FHI-aims calculations:

To launch a parallel FHI-aims calculation type:
mpirun -np 4 aims.x | tee “output-file“

– The mpirun -np 4 command starts FHI-aims in parallel on four cores.

– ATTENTION: do not start another FHI-aims run simultaneously.
That would slow down BOTH calculations considerably.

• Molecular building tools:
Out of the several atomistic model building tools widely available, Avogadro is a very intuitive
molecular editor and straight forward to learn. We will provide instructions throughout the
tutorial whenever necessary.

• Visualization tools:
To visualize structures, vibrational modes, charge density plots, etc., several programs in-
cluding molden, vmd, and jmol are installed on your workstations. In Appendix I you will
find instructions on how to use Molden and VESTA.

• Utility scripts:
DFT output files are complex, so we use utility scripts to extract important data. In the
$COURSE/CODE/utilities directory you will find tools like aims-SCF_convergence.awk and
get_relaxation_info.pl to monitor the simulation, as well as create_xyz_movie.pl to
track the geometry optimisation. In this tutorial, additional scripts can be found in
$TUTORIALS/Tutorial_2/utilities.
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Part I: Local structure optimisation

Problem I: Planar H3O+

This exercise covers how to perform geometry optimizations. Specifically, we will relax the H3O+

molecule starting from an initial planar guess for the geometry.

Educational Objectives

• Learn how to perform a geometry optimization (structural relaxation) in FHI-
aims

• Visualize molecular structures and molecular relaxations.

Tasks

1. Figure 1 shows a geometry.in file, which can also be found in the $TUTORIALS/ directory.
Please use this as the starting point for your structure relaxation.

# Initial guess for planar H3O+
atom 0.00 0.00 0.00 O
atom 0.92 -0.53 0.00 H
atom -0.92 -0.53 0.00 H
atom 0.00 1.06 0.00 H

Figure 1: This geometry.in file gives a starting point for the planar H3O+ cation.

2. Create a control.in file, using the control.in file from the previous exercises as a template.
For your xc functional (i.e. method), specify pw-lda. This time, use spin none and, as we
are interested in a cation, charge 1.0. Finally, add the keyword relax_geometry trm 1E-3
to request structural relaxation. Your control.in should look similar to the example shown
in Fig. 2.

# Sample input file for the relaxation
# of the H3O+ molecule
# ######################################

xc pw -lda
charge 1.0
spin none

# ###### SCF Accuracy ####################
sc_accuracy_eev 1E -2
sc_accuracy_etot 1E -5
sc_accuracy_rho 1E -4
sc_accuracy_forces 5E -4
sc_iter_limit 100

# ###### Relaxation ######################
relax_geometry trm 1E -3

Figure 2: The control.in file used for the structure relaxation of the cation H3O+.

As in the exercises before, the basis set must be included in the control.in file. Use the
“light” species defaults for O and H atoms.
cat $SPECIES/light/01_H_default >> control.in
cat $SPECIES/light/08_O_default >> control.in
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3. Run FHI-aims.
aims.x | tee H3O+_planar_relaxation.out

4. To visualize the results, copy the tool create_relax_movie.py from
$TUTORIALS/Tutorial_2/utilities into the working directory. Apply it to the output and
pipe the result to a new file using the command
python3 create_relax_movie.py H3O+_planar_relaxation.out > H3O+.xyz
Open the file H3O+.xyz with a visualizer.
molden H3O+.xyz or jmol H3O+.xyz

What does the fully relaxed structure look like? Do you believe that this could be the actual total
energy minimum?

Problem II: A vibrational analysis of planar H3O+

Now we will check whether our obtained geometry is a local minimum or saddle point by
performing a vibrational analysis.

Educational Objectives

• Learn to calculate vibrations in FHI-aims

• Recognize transition states

We will use the python script get_vibrations.py in a folder that contains a control.in and
geometry.in file. The script is located in $TUTORIALS/Tutorial_2/utilities.

Tasks

1. Use the same control.in as in Problem I. Next, copy the optimized geometry from the
previous exercise. This should be contained in the file geometry.in.next_step.

2. Run the vibrational script.
>python3 get_vibrations.py -r aims.x -x -p -w -d 0.002 H3O+_planar 2 >
H3O+_planar.vib.out
This will create folders containing the single calculations and calculate the vibrational fre-
quencies. For information about the python script and its options type:
>python3 get_vibrations.py -h

3. Inspect the H3O+_planar.vib.out file and check which other files were obtained.

The script get_vibrations.py produces several output files - most importantly the
H3O+_planar.vib.out and the H3O+_planar.xyz file. The H3O+_planar.vib.out file contains
basic information about the vibrational frequencies, zero point energies and infrared (IR) intensi-
ties. In addition, the H3O+_planar.xyz file contains geometrical information about the vibrational
modes.

If the Hessian (the matrix of the second derivatives of the total energy with respect to the atomic
positions) is positive definite (i.e., there are only positive eigenvalues), the structure is in a local
minimum. If not we, found a saddle point or a maximum. Formally, in this case the Hessian will
have imaginary vibrational frequencies. However it is also common to output them as negative
numbers. There are 3N -6 non-zero modes (3N -5 for linear molecules), where N is the number of
atoms. Due to numerical errors you will typically find the remaining 6 (5) ’zero’ frequencies to
be in the range of ∼ ±15 cm−1. They may be negative, but as their values are numerical errors
and not physical, these zero modes should be ignored when decided if the structure is in a local
minimum.

Visualize the eigenmodes of the molecule:
Create a molden file by applying following the script to the FHI-aims output H3O+_planar.xyz of
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the vibration calculation (troublemaker.pl can be found in the $TUTORIALS/Tutorial_2/utilities
folder):
> ./troublemaker.pl -xyz2molden H3O+_planar.xyz > H3O+_planar.molden.
Visualize the eigenmodes in the molden file:
> molden H3O+_planar.molden

In this example, H3O+ has one imaginary frequency. What does the corresponding mode look like
(see MOLDEN tutorial)?

Problem III: Getting H3O+ right
An imaginary frequency indicates that the curvature of the potential energy surface (PES) along
that mode is negative. In other words, following that mode leads to a structure with lower energy.
Therefore, a reasonable guess would be to distort the geometry along this direction and optimize
the structure again. This is what we are going to do next!

Educational Objectives:

• Use the vibrational analysis of transistion states to find the nearest energetic
minimum structure

Tasks

1. Take the H3O+_planar.distorted.vibration_1.geometry.in file from the previous exer-
cise. It contains the planar geometry distorted along the imaginary mode.

2. For the distorted geometry, optimize the structure again (as described in Problem II).
> aims.x | tee H3O+_distorted_relaxation.out

What does the optimized structure look like? How does the energy compare to the planar optimized
structure of Problem I?

Problem IV: Pyramidal H3O+

Check whether the 3D geometry of H3O+ is stable by performing a vibrational analysis as de-
scribed in Problem I.

Tasks

1. Perform a vibrational analysis of the pyramidal H3O+ cation and check if this structure is
stable.

Problem V: Infrared spectrum
In addition to the information about the structural stability, a vibrational calculation also gives
the infrared (IR) spectrum. In this exercise we will compare the IR spectrum for the planar and
pyramidal geometry, and optionally, for different numerical settings and different functionals.

Educational Objective

• Visualize the IR-spectrum of the H3O+ cation

• Compare experimental and calculated results.

To get started, we can use the data calculated in Problem II and Problem IV. Compare the vibra-
tional frequencies obtained in both problems.

Tasks
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1. The IR-spectrum can be visualized using molden, see MOLDEN Tutorial.

2. Repeat the same steps for the vibrational analysis of the planar structure.

3. Compare your spectra with the experimental vibrational frequencies. You can look them up
online at the NIST web book:
http://webbook.nist.gov/cgi/cbook.cgi?ID=C13968086&Mask=800#Electronic-Spec

Note:
As you see, the IR-spectrum is very sensitive to the structure. Comparing a
calculated IR-spectrum to an experimental one can shed light on the structure
that is predominantly present in experiment.

Optional: Convergence of numerical settings and performance of different
methods.
Tasks

1. Perform convergence tests going from light, to tight and then to really tight settings for the
infrared spectrum and for the 3D geometry (use pw-lda functional).

Important:
Since a harmonic IR-spectrum only makes sense for an optimized geometry,
make sure that you request a geometry optimization in your control.in file,
i.e. set relax_geometry trm 1E-3.
If set, the vibrational script optimizes the geometry before doing the actual
calculation for the vibrations.

2. For light settings, set the xc-functional (i.e. method) to the PBE functional you used in the
first tutorial. Compute the IR spectrum again and compare it to the pw-lda spectrum.

3. Compare again with the experimental vibrational frequencies.
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Part II: Exploring conformers and the potential energy surface

Educational Objectives:

• Learn how to use a molecular editor

• Continue to build up expertise to visualize molecular structures

• Experience molecular conformers first-hand

As the second smallest amino-acid and a key building block of organic biomolecules, alanine has
been the subject of intense experimental and theoretical characterisation. After some confusion
over its ground-state geometry, it has now been established that alanine can assume different stable
configurations that are very close in energy. These conformers of alanine represent different local
minima, each of them stabilised by internal dispersion bonds between the functional groups of
the molecule. Different conformers can be realised by rotating the functional groups around key
molecular bonds, without breaking any of the bonds.

Problem VI: Building alanine with a molecular editor
Tasks

1. Open Avogadro by typing avogadro2 in command line.

2. Make sure you are in Tool Settings mode and you can see the Draw Settings. The Element
drop down menu lets you select the atomic species you would like to place. Uncheck the
tick-box Adjust Hydrogen. Now you can select your first atom type and place an atom in
the editor. When you place a second atom you can create a bond between the two atoms by
keeping the left mouse button pressed and dragging the cursor to the first atom. Clicking on
the bond changes it from single to double to triple and back to single. A right mouse button
click should remove the bond.

3. Use the Avogadro editor to build an alanine molecule as attached to the tutorial document.

4. Click on Extensions in the top bar of the Avogadro program. This brings up the force-field
structure relaxation tool box Open Babel. Using the default settings, press the Optimize
Geometry button to launch the structure relaxation. Avogadro will now minimize the forces
acting on all atoms until the optimal structure is reached.
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You now have an alanine molecule in front of you on the computer screen. You can use Avogadro’s
view features to rotate the alanine molecule on the screen or zoom in and out. The equilibrium
structure of your alanine molecule has been determined with a force field. Next we will check what
DFT will do to this structure.

Problem VII: Relaxing alanine with DFT
Tasks

1. In Avogadro, output the final geometry as xyz file by going to File→Save As.

2. Generate an FHI-aims geometry.in file by hand, based on the xyz file output.

3. Adjust the control.in from the previous exercise to alanine, e.g. add the correct basis
functions using the light Tier 1 setting. Switch back to the PBE functional.

4. To describe the van der Waals effects in alanine correctly, you need a better exchange-
correlation functional than PBE. This can also be achieved with the Tkatchenko-Scheffler
van der Waals corrections (Phys. Rev. Lett., 102, 073005 (2009)). To activate them, add:
vdw_correction_hirshfeld.

5. Launch a parallel FHI-aims calculation to relax your alanine molecule ( 5min):
mpirun -np 4 aims.x | tee output-file

6. Apply a utility script ( create_relax_movie.py) on the “output-file“ to generate the xyz
file as in Problem I, visualize the relaxation process in Molden and take note of the final
structure.

7. Create a postscript file (alanine.ps) of your relaxed molecule. Can you spot any differences
in the pre- and post-relaxation geometries?

8. Take note of the initial and final total energy and report the final total energy that you
obtain to the white board at the front of the class.

NOTE: the convergence settings here are set to average values to speed up calculations during
the practical class. In real calculations, convergence parameters are typically benchmarked and
assigned tighter settings.
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Part III: Visualizing electron densities and eigenstates
Chemical reactions and many important physical effects (such as the formation of interface dipoles)
are triggered by electron rearrangement. They are often associated with filling or emptying of
molecular frontier orbitals. In this exercise, we will demonstrate how charge distributions are
visualised and investigate how well the “actual” filling of a molecular orbital corresponds to the
associated eigenstate of the neutral molecule.

Educational Objectives

• Visualization of charge distributions

• See how orbitals (wave functions) and charge-density differences compare

• Understand the difference between orbital eigenvalues and ionization energies

Problem VIII: Outputting and visualizing molecular orbitals
Tasks

1. The molecule for the present example is para-benzoquinone, a readily available small molecule
that is a strong electron acceptor. You can either create the geometry input for this molecule
yourself (using Avogadro) or use the provided input file from the Templates folder.

2. Create a control.in input file for a spin-polarized, uncharged PBE calculation of the molecule.
Use spin collinear and switch_external_pert 10 safe. We want to visualize the high-
est occupied molecule orbital (HOMO) and the lowest unoccupied molecular orbital (LUMO)
in form of a standard cube file. Request the output of the wave functions in the control.in
file using the keywords:
output cube eigenstate homo
cube filename HOMO.cube
output cube eigenstate lumo
cube filename LUMO.cube

We also want to look at charge density differences, so we need the total density of the
molecule. Add:
output cube total_density
cube filename total_density_uncharged.cube

By default, FHI-aims will figure out the region to plot into the cube files by itself (to change
this, see FHI-aims User Manual).

3. Run the calculation and look at the output. In the final occupation numbers, search for the
energies of the HOMO and the LUMO. How do these energies compare to the experimental
values of 10.7 eV for the ionisation potential and 1.9 eV for the electron affinity?

4. Next, use your favourite tool to plot the cube files (see appendix on how this is done with
molden, but you may use vmd or vesta). Do HOMO and LUMO both have π character?

5. To see how well the eigenvalues and eigenstates correspond to the physical situation of charg-
ing a molecule, prepare and run two more inputs for the molecule with one negative and and
one positive charge.
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6. Check the total number of electrons in neutral and charged calculations. Obtain the electron
addition and removal energies by subtracting the total energy of the charged systems from the
total energy of the uncharged system. This is also known as the ∆SCF approach. Compare
the values with the HOMO and LUMO eigenvalue of the neutral molecule. How much do
they differ?

7. The change in the electron density upon charging (positive and negative) can be obtained by
subtracting the total density of the charged system from the total density of the uncharged
system. To that end, a python-script called subtract_cubes.py is provided in the utilities
folder. Copy this script and the total_density.cube files into a separate folder and execute
> python3 subtract_cubes.py total_density_uncharged.cube
total_density_charged.cube chargediff.cube

This will subtract the file given as second argument from the file given as first argument
(adjust the file names accordingly). The result will be written to the file provided as final
argument. Note that the cube files need to be generated with the same cube file settings
in control.in. Visualise the density differences. Do you see qualitative differences to the
eigenstates? Can you explain (or at least speculate) on the reasons for them?
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Appendix I: Molden
Molden is a small, free tool which allows visualization of non-periodic structures, geometry opti-
mizations, vibrations, and cube files. It can be used for all visualisations during tutorial 1. In the
utilities folder, we provide several scripts which convert the output from FHI-AIMS to the molden
format.

To open molden, simply type
molden or molden filename
in the command line.
Two windows will open, one named “MOLDEN”, which contains the structure (and is empty if

you didn’t provide a file), and one named “MOLDEN Control” which contains several buttons. To
open a new file, use the "Read" button.

Below, we will describe how to visualize the output from the individual task. Of course, molden
can do much more than what is shown here - feel free to play around. If you want to close molden,
please use the skull icon in the middle of the control window.

Geometry single points

1. Create a molden file by appyling the script create_relax_movie.pl to the FHI-aims output
of a single point calculation

2. Open the file typing molden filename . On the top left corner of the Molden Control Win-
dow. The geometry of the system should appear in the Molden Window.

3. You can change the display options by playing around with the Draw Options in the bottom
left corner of the Molden Control Window. Good results are often achieved by disabling
shade and setting “Solid” to “Ball and Stick”. Feel free to experiment!
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Geometry relaxations

1. Create a molden file by applying the script create_relax_movie.pl to the FHI-aims output
of a geometry relaxation.

2. Open the file typing molden filename . On the top left corner of the Molden Control Win-
dow, the “Select Point” field should be active now. (See picture)

3. Watch a movie of the relaxation by clicking on the “Movie” button. If the movie is too fast,
use the “sand-clock” button to set a delay between the individual frame.

4. You can also walk though each point of the geometry optmisation using the “Next” and
“Prev” buttons.

5. Clicking on the “Geom. Conv” button in the bottom right corner of the Molden Control
window will open a new window with information about the change of energy, maximum
force, and maximum step size for each step.

Vibrations

1. Create a molden file by applying the script > ./troublemaker.pl -xyz2molden H3O+.xyz
> H3O+.molden to the FHI-aims output H3O+.xyz of a vibration calculation (troublemaker.pl
can be found in the $TUTORIALS/Tutorial_2/utilities folder).

2. Open the file typing molden filename . On the top right corner for the Molden Control
Window, the “Norm. Mode” button should be active now, as highlighted in the picture.

3. Click on the button. Two more windows will open. The window called “spectrum” will
provide you with an simulated infra-red spectrum based on the eigenvalues and their inten-
sity. The bottom of this window provides several possibilities to alter the appearance of the
spectrum or print it. The second window is called “Molden Frequency Select” and contains a
list of all eigenmodes along with their frequency and IR intensity. By choosing one of these,
the geometry in the molden window becomes animated and displays the corresponding eigen-
mode. The box scale factor at the bottom of the window can be used to amplify or damp
the movement of the atoms.
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Cube files

1. Cube files are generated directly by FHI-AIMS using the output cube syntax (see manual
section 3.19).

2. Open molden without any filename by typing molden.

3. Click on the “Dens Mode” button in the left central panel. The Molden control window will
change and show different buttons, see picture.

4. Click on the “Rd/Wr Cube” button in the bottom right corner. Choose read, Gaussian and
give input the file name of your cube file when asked.

5. When the file opens, use the “Space” button in the top right corner to choose an isovalue for
the display of the cube file. Try value 0.01.

Creating geometries
Besides pure visualization, molden also efficiently generates and saves geometries for molecular
structures. Molden uses a z-matrix editor. A detailed explanation of z-matrices is beyond the scope
of this work, but can be found online, e.g. under http://www.cmbi.ru.nl/molden/zmat/zmat.html.
Even for people not familiar with z-matrices, generating input structures is usually easy and
intuitive. This function is briefly explained here for the example of para-benzoquione, the molecule
used in the last part of Tutorial 1, and shown in the picture below.
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1. Open molden and go to the z-matrix editor. A new window will appear which contains an
empty field and several buttons, as shown in the picture below.

2. Begin by clicking on the "Add Line’ button and select a carbon atom. A green circle should
appear on your screen now.

3. The fastest way to proceed is to mark the carbon atom, choose ’Substitute atom by fragment’
from the Zmatrix Editor, and select -Phenyl. This will turn the atom into a completed ring,
saturated with hydrogen atoms on all carbon atoms but one. The formally empty box will
now contain a list of all atoms. The first row is for bond distance, the second row is bond
angles and the forth row is dihedral angle.

4. To add additional atoms, select the “Add Line” button again. Choose “double” as bond
length, and an oxygen atom from the periodic table. Molden will now ask you to select
3 atoms to define the connectivity. These are the atoms to which bond length, angle and
dihedral angle are defined. Click on the only carbon atom which has no hydrogen on it, and
sub-sequentially on 2 neighbouring carbon atoms. A new line should appear.

5. If you made a mistake and want to delete the atom, click on the “delete line” button. If you
were successful, delete the hydrogen atom opposite to the oxygen atom. Then, add another
oxygen atom in its place, the same way you added the first one.

6. Once you are done, save the geometry by clicking on “Cartesian” in the lower right corner
of the Zmatrix Editor, choose “XYZ” and provide a file name. Save by pressing return, and

15



quit molden via the Skull icon.

7. Use an editor or an script to adjust the xyz-format to the FHI-aims geometry.in format.
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Appendix II: Visualization with VESTA
Visualizing your results from density functional calculations is useful and important for a couple
of reasons. First, you can visualize the structure as it was read by FHI-aims and check its
accuracy. This is a fool-proof way to check that the geometry handled by the code is actually the
one you want. Second, you can view ‘volumetric data’ superimposed on the structure of whatever
system you are dealing with. Volumetric data can be any kind of data written to a real-space grid
including charge densities, wave functions, potentials, etc. Visualization of volumetric data can
help you extract meaningful physics from your calculation. This document is a quick-start guide
to visualizing output from FHI-aims with VESTA.
VESTA is a public, easy-to-use application for visualization of atomic structures and volumetric
data. You can find it here: http://jp-minerals.org/vesta/en/
The complete manual for VESTA is here:
http://www.geocities.jp/kmo_mma/crystal/download/VESTA_Manual.pdf

Visualizing crystal structures
It is difficult to understand what a bulk, three-dimensional crystal structure looks like just by
reading atomic coordinates. Luckily, VESTA will read the geometry.in file needed for FHI-aims
and visualize the crystal for you. Type vesta to launch.

Figure 3

Now navigate to File and open your geometry.in file for FHI-aims. It should show the crystal
structure you are interested in. An example geometry.in file for wurtzite ZnO and its appearance
in VESTA are shown below and in Fig. 3.

lattice_vector 3.27534473 -0.07200997 -0.00749503
lattice_vector -1.57091511 2.87405204 -0.05082762
lattice_vector 0.01006313 0.10435241 5.29125719
atom 0.04290507 1.88121444 -0.06093020 Zn
atom 1.66090983 0.94898484 2.59987036 Zn
atom 0.04188438 1.91975639 1.94486746 O
atom 1.66718882 0.99019168 4.60509159 O
You can rotate the structure just by clicking and dragging the mouse. If you lose track of

what direction you are looking at, click the ‘a,’ ‘b,’ or ‘c’ buttons on the top left. These will
automatically orient the camera with the first, second, or third crystallographic direction. Notice
the three crystallographic directions are given by the axes in the bottom left corner. If you click on
‘Tools’ at the top left of Fig. 7, you can select the ‘Animation’ rotation mode. With this selected,
the crystal will slowly rotate in the direction you choose.

Fig. 3 looks ok, but it can be improved a lot. When looking at a periodic structure, it is helpful
to increase the number of unit cells displayed so that you can see how different cells meet at their

17



Figure 4

boundary. Click on Objects → Boundary to get the menu shown in Fig. 4. The boundaries of the
displayed structure are set by ‘xmin’ and ‘xmax’ in reduced coordinates (and likewise for y and z).
Setting the boundaries to 0 and 1 shows one cell. Try setting all of the maximum boundaries to 2.

Figure 5

That looks better, but it is still difficult to see how the material is bonded. To fix that, click
on Edit → Bonds. You should see the menu shown in Fig. 5. You have a few choices on how
VESTA will search for bonds. The simplest, catch-all method is to click on ‘New’, choose ‘Search
molecules,’ check ’Do not search atoms beyond the boundary,’ and then set a maximum bond
length. This choice will draw a bond for any two atoms that are less than the maximum bond
length away from each other. You need to determine a reasonable maximum bond length for your
structure. By searching atoms bonded only to ‘A1’ and/or ‘A2,’ you can search for bonds only
involving those one or two chemical species. Now that the bonds are drawn, it is much easier to
visualize the crystal and how the atoms are arranged when you rotate the crystal. For reference,
a single unit cell is still outlined in black by VESTA.
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Visualizing cube files
Navigate to File and open your .cube file from FHI-aims. It should show the atomic structure
and some colored surfaces, something like Fig. 6. The yellow surfaces are called isosurfaces −
surfaces of constant value. In the case of plotting ρ or ρi, they are surfaces of constant charge
density. These isosurfaces are analogous to reading a topographic map in 2D. Instead of lines at
constant value in the 2D case, we now visualize surfaces. Try clicking the different options under
‘Style’ on the left to change the appearance of the structure (Fig. 7). You can turn isosurfaces on
or off by clicking the ‘Show isosurfaces’ box. And you can change the isosurface style by choosing
a different option under ‘Style’ (the second ‘Style’ panel). The ‘Show sections’ box is probably also
checked. Sections are cuts through the charge density on the boundary of your plotting box. They
appear as contour plots on the sides of the plotting box. These can be useful for periodic systems,
but for molecular systems, the density near the edges of your plotting box is so low, there is not
much meaningful information there.

Figure 6

The tools on the left side of the screen (very left side of Fig. 7) allow you to measure bond
lengths, angles, etc. with your mouse. For example, click the one with the little arrow between two
atoms, then click on two atoms in the structure. In the output dialogue on the bottom, VESTA
should tell you the distance between those two atoms. The next tool down the list will allow you
to measure bond angles. Click it, then click on three atoms in the structure. The angle formed by
these three should be printed in the output dialogue.

If you navigate to Objects → Properties → Isosurfaces, you should see the ‘Properties’
menu shown in Fig. 7. Here, you can change the isosurface value by clicking on the number
underneath the ‘level’ label. You can also change the color or add multiple isosurfaces by selecting
‘New.’ Try selecting a reasonable isosurface value that allows you to see the character of the charge
density. Selecting isosurface values is subjective and can be tricky, as different values can show
very different shapes. One possibility is to select isosurface values that are a certain percentage of
the maximum value on the grid, which is conveniently reported by VESTA. Always selecting the
same percentage of the maximum offers some plotting consistency between different molecules.

Under the ‘General’ tab (Fig. 8), you can change the overall appearance of the viewer. You
can turn on/off the outline of the plotting box, remove the coordinate axes, or adjust the material
appearance. Under ‘Atoms,’ you can change the color of each species, the size of each atom, etc.
There are lots of customizable aspects to create exactly the look you want. Explore all the options!

Images can be exported by going to File → Export Raster Image or File → Export Vector
Image. Either of these will save a snapshot of the viewing window. Be sure to zoom in and orient
the molecule correctly for the best quality image. That’s it! Now you can visualize your results
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Figure 7

Figure 8

from FHI-aims.
VESTA also has a 2D display mode. Sometimes, making a 2D contour plot on a slice through

a certain plane looks better than an isosurface in 3D. To start the 2D mode, click on Utilities
→ 2D Data Display. You should see the menu shown in Fig. 9.

First, you must select which plane you want to make your 2D slice through. Click on ‘Slice’ to
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Figure 9

get the second menu shown in Fig. 9. Set a plane based on its (hkl) index. Don’t worry about
setting the distance from the origin - you will be able to visualize data in all planes parallel to the
one set by (hkl). The default setting is (hkl) = (001). If your molecule is planar and oriented in
the xy-plane, this is a good choice. Click ‘Ok.’

Figure 10

Now you need to set the saturation levels for the color scale. The maximum value will be the
grid value that appears red, and the minimum value will appear blue. These do not have to be
100% and 0%. Usually, the maximum and minimum values on the grid are very far apart, with
most of the grid points taking a value much closer to the minimum than the maximum. If you
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simply set the maximum and minimum to 100% and 0%, you probably won’t be able to see much.
The majority of the data points will be in a very narrow color band, and you won’t be able to see
much detail at all. Next to ‘Max,’ set the saturation level to something around 3%. Then set the
‘Min’ level to 0%. This will probably take some tuning to get a nice image − you can reset these
later. Now click on the blue plane with an arrow going through it and scroll with the wheel on the
mouse. You should see a new image with every wheel click as you scroll through different planes
parallel to the one you set, something like Fig. 10. Each plot is a slice through the density parallel
to the (hkl) plane that you set. Try setting different saturation levels and a different (hkl) plane.
Again, you can export an image by navigating to File → Export Raster Image.

Now check the ‘Bird’s-eye view’ box. As long as the blue plane with the arrow going through
it is checked, you can still scroll through different plane levels. Now, though, click and drag the
plotting area. You should be able to rotate the plotting plane, and the plot now has depth. The
colors correspond to the height of the features out of the plotting plane. To see more dramatic
features, you might want to increase the maximum saturation level. Now you can generate a
surface corresponding to the density through a single plane. 2D displays can be easier to look at
than 3D isosurfaces, especially for planar molecules.
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